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PSMA Magnetics Committee Meeting Agenda — 2026 Workshop Banner

Power Magnetics @ High Frequency Workshop

e

I\\ PSMA Magnetics Committee - 21 March 2026, San Antonio, TX USA




PSMA Magnetics Committee Meeting Agenda — 2026 APEC Website
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WELCOME TO EXHIBITORS & TRAVEL
ATTENDEES ¥  STUDENTS v  SPEAKERS v v~ PRESS v v CONTACT
APEC 2026 PARTNERS INFORMATION

PSMA MAGNETICS
WORKSHOP

Date: Saturday, March 21
Time: 7:00 AM - 6:30 PM
L ion: Henry B. ion Center, Room TBA

While not part of the official APEC Program the Magnetics Workshop, organized jointly by the Power
Sources Manufacturers Association (PSMA) and the IEEE Power Electronics Society (PELS), held the
Saturday before APEC begins, has become an established tradition. The 2026 workshop will be held
on Saturday, March 21, 2026.

The 2026 Power Magnetics @ High Frequency Workshop is the 10th annual workshop held in
conjunction with APEC. The purpose and focus of this workshop are to identify the latest
improvements in magnetic materials, coil (winding) design, construction and fabrication,
evaluation and characterization techniques and modelling and simulation tools. The theme of the
2025 workshop will be integrated magnetics, defined as magnetic structures that perform two or
more functions. The workshop will address various aspects of integration for both lateral and
vertical power delivery. The planned topics include various levels of integration ranging from

magnetic components co-packaged with silicon in Power System in Package (PSiP) devices,
magnetics embedded in substrates, fabricating magnetics as part of the semiconductor wafer
process and traditional core structures used in unique ways. The workshop will also cover
integration of magnetic functions for new circuit topologies including coupled inductors, LLC,
trans-inductor voltage regulator (TLVR) and variable-inverter-rectifier-transformer (VIRT).

Registration for this workshop is separate from the registration for the APEC conference.
Registration for the workshop is limited and will open in late 2025.

for the latest information on the workshop including registration and the detailed
agenda.

https://apec-conf.org/attendees/special-events-social-activities/psma-magnetics-workshop/
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PSMA Magnetics Committee Meeting Agenda — 2026 APEC Website

2% APEC Daily Schedule | APEC X+
< c 25 apec-conf.org/attendees/daily-schedule/
WELCOME TO EXHIBITORS &

ATTENDEES v  STUDENTS v  SPEAKERS Vv
APEC 2026 PARTNERS

Check Out Our Daily Activities

APEC 2026 SCHEDULE AT

A GLANCE

Please note that times are subject to change as the final details of the conference
are settled. Locations will be announced as they become available.

<O

All events and sessions are in the Henry B. Gonzalez Convention Center unless
otherwise noted.

for a floor plans of the Henry B. Gonzalez Convention Center.

SATURDAY, MARCH 21

7:00 AM - 6:30 PM PSMA/PELS Magnetics Workshop

Registration Open
Street Level, Hall 4 West Registration

4:00 PM - 7:00 PM

https://apec-conf.org/attendees/daily-schedule/
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PSMA Magnetics Committee Meeting Agenda — 2026 Workshop Planning

v ldentify Themes

» Overall Theme: Measurements and Data Trends to Achieve Better Analytic Models and Simulation
Models Towards Improved Design Tools

» AM Theme: Developing Analytic and Simulation Models from Measurement Data
» PM Theme: Starting with Design Basics to Achieve Design Automation

v PSMA Special Projects Request
» Approved by PSMA BOD on May 16, 2025

v’ 2026 Magnetics Workshop Banner

» Draft available — May 20, 2025
=  Use for PSMA 2025 Q2 Newsletter article

v’ 2025 PSMA 3 Quarter Newsletter
» Article published — September 9, 2025




PSMA Magnetics Committee Meeting Agenda — 2026 Workshop Planning

O Next Steps (June 2025 thru October 2025)
v Identify — Invite — Confirm Keynote presenters
> ldentify — Invite — Confirm Lecture presenters — (8/9) 89% complete
> ldentify — Invite — Confirm Technology Demonstrations — (8/12) 75% complete
O Open Registration by November 14
» Maintain Same Registration Fees as 2025 Workshop
O Partners
» Maintain Same Rates as 2025 Workshop
U Visa Letters
O Release 2025 workshop presentation from firewall

O Advertisements
» PELS Website
» How2Power
» Bodo Power Systems
» Other

O Presenter (Speaker, Demo, Poster) Instructions — set up drop box

O Attendee Instructions PSMH
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Home

2025 Workshop Partnership

Saturday March 15, 2025
Georgia World Congress Center, Atlanta, Georgia

Please complete the information below to sign up as a partner for the Power Magnetics @ High Frequency Workshop.

Platinum Partner
$2,500

« Company logo in web page linked to URL of choice

« Company recognition at entrance

+ Company logo on daily introduction and break slides

« Company recognition in *blast e-mail’ announcing registration

+ Company logo on social media promotion

+ One free registration

« Additional registrations at preferred PSMA rate

+ Company supplied logo can be displayed within workshop

« Company exhibit table by registration desk onsite

» Company may provide branded lanyards for participants {~150 pcs)

Gold Partner
$1,500

+ Company logo in web page linked to URL of choice

« Company recognition at entrance

+ Company logo on daily introduction and break slides

« Company recognition in *blast e-mail’ announcing registration
« Company logo on social media promotion

+ Register at preferred PSMA rate

Sorry... This form is closed to new submissions.




PSMA Magnetics Committee Meeting Agenda — 2026 Workshop Planning
Registration Fees

» Early registration

« PSMA Member/IEEE Member: $295

« Non PSMA Member/Non-IEEE Member;: $395
* Normal Registration

« PSMA Member/IEEE Member: $345

« Non PSMA Member/Non-IEEE Member: $445
« Walk-In On site registration:

« PSMA Member/IEEE Member: $445

« Non PSMA Member/Non-IEEE Member: $545




PSMA Magnetics Committee Meeting Agenda — Magnetics Workshop - AM Session Presenters

O AM Theme: Developing Analytic and Simulation Models from Measurement Data
> Keynote:
= Peter Zacharius (University of Kassel)
= Analytic Models
» Lecture presenter 2:
» Lucas Pniak — SAFRAN Research and Technology Center — Industry — verbal confirmation

= Semi Analytical Broadband Electromagnetic Modeling of Planar Transformers Considering
Capacitive Couplings

= Lecture presenter 3.
» Miroslav Vasic/Danile Rios Linares — University of Madrid — Academia
= Artificial Neural networks (ANN) and Digital Twin to optimize DAB transformer design
» Lecture presenter 4.
» Reddy Andapally Bharadwaj — CBMM — Industry
» Data Collection and Analysis to Create Accurate Material Models for FEA Simulation
» Lecture presenter 5:
= Alex Hanson — UT — Austin — Research
» Qualifying measurement data, eliminating bias
» Thomas Guillod — Dartmouth — Research — Not available for APEC 2026




PSMA Magnetics Committee Meeting Agenda — Magnetics Workshop PM Session Presenters

U PM Theme: Applying Design Basics to Achieve Design Automation
v' Keynote:
= Asier Arruti Romero — University of Mondragon — Academia

= From the Steinmetz Equation to an Unified Magnetic Loss Model: Bridging Empirical Equations
and Physical Insight

v' Lecture presenter 7:
=  Alfonso Martinez — Wurth Elektronik

» Modelling Stray Capacitance and Leakage Inductance in Planar Magnetics: The Ultimate
Parasitics Analytical Model

v' Lecture presenter 8:
» Andrija Stupar — SIMPLIS Technologies — Industry —
= Developing Effective Magnetics Models for Power Electronics Circuit Simulations
v' Lecture presenter 9:
= Chema Molina — Frenetic — Industry
= Magnetics Design Automation from Excel spreadsheets to Al




Technology Demonstration Presenters

Presenter 1:
» Who — Rohde & Schwarz — Industry
= VNA — S-Parameters
Presenter 2:
= Who - Hioki — Industry
= Power analyzer, LCR meter, Impedance Analyzer
Presenter 3:
= Who - Affiliation — Industry
= Dielectric Withstanding Voltage/Insulation resistance
Presenter 4:
» Who - PE Systems — Industry
= Double Pulse Set
Presenter 5:
= Joaquim Tristan - UPITT — Academic
= Automated Test Systems
Presenter 6:

= Bachman/Wohlrath/Reibenweber - Tridelta/STS/Colburg
Industry/Academic Collaboration

= Next generation of ferrite cores

PSMA Magnetics Committee Meeting Agenda — Magnetics Workshop — Tech Demo Presenters

v Presenter 7:

= Marcin Kacki/Student - Hitachi Energy/University
of Madrid — Industry/Academia collaboration

= |mpact of unequal flux distribution on power
loss (potential poster)

v" Presenter 8:
= Jun Wang - Bristol
= TPT
v" Presenter 9:
= Alfonso Martinez — Wurth —
= CoreDataX
v" Presenter 10:
= |Lukas Mueller - Micrometals — Industry/Academic
= Current Driven Core Loss
» Presenter 11:
= Michael Freitag - Yageo —
= TBD
» Presenter 12:
= JC Sun/Tobias Trupp — BsT/Magnetec — Industry

= |nsertion Loss Nanocrystalline COIPSMn

— Academic

Industry

Industry



PSMA Magnetics Committee Meeting Agenda — Magnetics Workshop — Student Posters

» Presenter 1:
= Nick Kirkby — ASU
= NIST Standards — Error Analysis
> Presenter 2:
= Who - Affiliation
= TBD
> Presenter 3:
= Who - Affiliation
= TBD
> Presenter 4.
= Who — Affiliation
= TBD
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PSMA Magnetics Committee Meeting Agenda — 2026 Industry Session Planning

O Previous Industry Sessions

» Presentations from industry sessions of 2023, 2024 and 2025 are not indicated on Presentations” tab
of the Magnetics Technical Forum

» Action Iltem: John Horzepa to check with APEC Industry Session chairs if we can restart the practice
of making the APEC industry session presentations available on the “Presentation” tab of the
Magnetics Technical Forum of the PSMA website if we wait one year after each APEC to place the
presentations of the technical forum.

» This proposal has been accepted

» Ed (APEC 2023 and 2024) and Matt (2025) to provide John with IS session presentations from
indicated years




PSMA Magnetics Committee Meeting Agenda — 2026 Industry Session Planning

v |dentify Themes
» Manufacturing Challenges and Directions
» Magnetic Materials for Existing and Emerging Applications
» Pairing Capacitors with Inductors to Create Better Solutions

v’ Steps prior to Opening of APEC 2026 Registration on October 21
» Confirm presenters
» Submission of industry session details — October 21, 2025

L Next steps
» Presenter instructions — compliment ePapers process with our own instructions
» Draft presentation reviews
» Milestones and schedules
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(Official Approved Industry Sessions)

APEC 2026 Industry Session Schedule

Day Session 1 Session 2 Session 3 Session 4
, ) . , L . -P Packaging for Al
What is the next Kller Al and Digital Twins Capacitor circuit design 30-Power Pac aging for
. L | . and its Application in
Tues AM application for wide Transforming Power essentials for modern Power Systems
. - . .
bandgap semiconductors Device Innovation challenges Optimization
Beyond Silicon: Integrated
Wed Al | Wide Bandgap Power | Al Tools for More Efficient
e Solutions for Next- Power Electronics Design
Generation Systems

Mew era of Power
Wed PM technulugleg_ Devices,

Topologies and

Improving Energy Magnetic Materials for
Thu AM1 | Efficiency and Availabilify | Existing and Emerging

Part 1 Applications Part 1

Improving Energy Magnetic Materials for

Thu ANZ | Efficiency and Availability Existing and Emerging
Part 2 Applications Part 2

Legend PSMA Curated - Organic

Session 6

5ession 5

Overcoming Technical and
Manufacturing Challenges
to Meet Market Demands

e

P airing Capacitors with
Inductors to Create Better
Solutions

Reliability: From Stress to
Strengthc Physics-Based
Reliability for Mext-
Generation GaN Power
Systems




PSMA Magnetics Committee Meeting Agenda — Industry Session Planning
Addressing Technical Manufacturing Challenges and Directions to Meet Emerging Market Demands

Presentation Presentation
Start Time @ EndTime

Presentation Title Presenter First Name ~ Presenter Last Name Email Address Organization

IS Committee IS11: "Overcoming Technical and Manufacturing Challenges to Meet Market Demands "

REQUIRED REQUIRED REQUIRED REQUIRED REQUIRED REQUIRED REQUIRED

Designing Bidirectional Power Stages:

Topology & Control Impacts on Planar . .
8:30 AM 8:55 AM ) . Nicola Rosano nrosano@standexelectronics.com Standex
Magnetic Construction and

Manufacturing
3D Printing to Fabricate Bobbins and

8:55 AM 9:20 AM . Peter Weiner peter.weiner@norwe.com NORWE
Other Passive Components

The Hidden Challenges of Design
9:20 AM 9:45 AM Transformers for Dual Active Bridge Marcin Kacki marcin.kacki@hitachienergy.com Hitachi Energy
Systems

Low-Power and High-Power Transformer
9:45 AM 10:10 AM Solutions to Support the Power Delivery  Claudio Canete-Cabeza Claudio.Cabeza@we-online.com Wiirth Elektronik
Network for Al in Data Centers

Chanllenge in Implementing Automation ) ) ) )
10:40 AM 11:05 AM L . . Martin Kuo martink@ITG-electronics.com ITG Electronics
& Robotics in Magnetics Manufacturing.

Voltage Rating of Metal Alloy Molded . . ) ) . . .
11:05 AM 11:30 AM Inductors David Ruiz Gomez David.Ruiz@we-online.de Wirth Elektronik

Customizable Magnetic Components for
11:30 AM 11:55 AM Next-Generation Power Electronics Using Xinru Li xinru.li@g-ame.com CBMM
Nanocrystalline Flake Ribbon

PSMA




PSMA Magnetics Committee Meeting Agenda — Industry Session Planning
Magnetic Materials for Existing and Emerging Applications

Presentation Title Presenter First Name Presenter Last Name Email Address Organization

IS Committee IS20: "Magnetic Materials for Existing and Emerging Applications Part 1"

REQUIRED REQUIRED REQUIRED REQUIRED REQUIRED REQUIRED REQUIRED

Relevant Magnetic Material Properties for

8:20 AM 8:45 AM Lukas Reilenweber Lukas.Reissenweber@hs-coburg.de Coburg University

Existing and Emerging Applications
Metal Chip Power Inductor for IVR
8:45 AM 9:10 AM Applications: High Performance with Toshio Hiraoka thiraoka@jty.yuden.co.jp TAITO YUDEN CO
Customizable Flexibility

Magnetic/Resin Composite Sheets for

High-Frequency Power Electronics: From o N .. - -
9:10 AM 9:35 AM ] . Hideki Ooyama hideki.ooyama.62h@asv.ajinomoto.com Ajinomoto Fine-Techno Co
Fundamental Properties to Packaging

Integration Challenges

Superparamagnetic Nanocomposites for
9:35 AM 10:00 AM Perp g_ o P Dale Huber dlhuber@sandia.gov Sandia National Laboratories
Power Electronic Applications




PSMA Magnetics Committee Meeting Agenda — Industry Session Planning
Magnetic Materials for Existing and Emerging Applications

Presentation Presentation
Start Time  End Time

Presentation Title Presenter First Name Presenter Last Name Email Address Organization

IS Committee I1S26: "Magnetic Materials for Existing and Emerging Applications Part 2"

REQUIRED REQUIRED REQUIRED REQUIRED REQUIRED REQUIRED REQUIRED

Multi-Cut Nanocrystalline Cores Through . ) ) .
10:20 AM 10:45 AM . . Abrahan Solis asolis@mkmagnetics.com MK Magnetics
Classical Modeling

Nanocrystalline Cores for EMI . )
10:45 AM 11:10 AM .. Tobias Trupp Tobias.Trupp@magnetec.de Magnetec
Applications

Role of Nb in Nanocrystalline Ribbon and . .
11:10 AM 11:35 AM . Naoki Ito naoki.ito@cbmm.com CBMM
Core Manufacturing

Fe-based Nanocrystalline Alloys for Power . . .
11:35 AM 12:00 PM L. Michael Freitag Michael.Freitag@yageo.com Yageo
Choke Applications




PSMA Magnetics Committee Meeting Agenda — Industry Session Planning

Presentation Presentation

. . Presentation Title Presenter First Name Presenter Last Name Email Address Organization
Start Time End Time 5 ;

IS Committee IS24: "Pairing Capacitors with Inductors to Create Better Solutions "

REQUIRED REQUIRED REQUIRED REQUIRED REQUIRED REQUIRED REQUIRED

A Practical Design Guide for resonant

8:20 AM 8:45 AM . Simon Reuning Simon.Reuning@vyageo.com YAGEO
Power Conversion

The Importance of Magnetic Components

8:45 AM 9:10 AM Symon Pasko Szymon.Pasko@te.com TE Connectivity - Schaffner
in EMC Filter
9:10 AM 9:35 AM El\fl Ftl-lter Success - Smart Inductor Jared Quenzer Jared.Quenzer@we-online.com Wiirth Elektronik
election

Title: Performance of Common-Mode

Chokes with Enhanced Differential-Mode

9:35 AM 10:00 AM ) ] ) Bryce Hesterman bryce.hesterman@usu.edu Utah State University
Inductance in EMI Filters Including

Capacitive Interactions
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PSMA Magnetics Committee Meeting Agenda — Special Projects — In Process

e Core Loss Database
—on-line needs formatting/styling
— URL: coredataX.com

— URL: https://www.psma.com/magdb-test

¥ Core Data eXchange x

< G % coredatax.com

PSMA

About

QaKx @ O

Core Data eXchange

Upload Data

100.0 kHz

View Data Resources

Welcome to Core Data eXchange!

This website is an open sourced repository for magnetic core loss data for
all types of core materials (powdered, ferrite, amorphous, nano
crystalline, steel). The point is to provide one place where core loss
measurements under any conditions (temperature, frequency, waveforms,
flux density, dc biased) can be stored and accessed.

The data is provided from various sources but its primarily intended that
the user of the site will also contribute to the database. The data can be
freely downloaded for the research or design of magnetic devices. A
universal data exchange format in JSON allows easy uploading, retrieval
and use by computer software.

The site is also intended to be a resource for those who want to know
how to do their own testing and provide a forum to exchange ideas.
What makes this site unique is that it is completely open source. That
means the user community provides the data and develops the website
to make better use of the data. The Magnetics Committee of the Power
Sources Manufacturers Association PSMA is sponsoring the site,
providing the money to set it up and on going administrative
maintenance.

z 0

Register Login

PSMA
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@ DuckDuckG i Y View Options
] B A - L
« =2 C coredatax_page3.html ® =
[] slamatouse [ watertown  [] Armstrang  [] Amazon [ Dotster [] RedExpert [] GitHub [JEmPlan  [Jugityss [] sinou [ Thevenl ctricaldu [] Trello  [] Encyclo_agnetica [] Mideo webmail ] WE Space »

pSMn Power Sources Manufacturers Association sign in

PSMA | Technical Forums | Magnetics

cox CoreDataX

A PSMA sponsored cross-disciplinary technical forum focused on magnetic core charactization,
core losses, magnetic materials, modeling, and real-world design applications.

SECTIONS About CoreDataX

Overview CoreDataX brings together engineers, researchers, and practitioners interested in magnetic materials and h]

components — covering core loss measurement, core loss modeling, AC permeability, temperature effects, Q-
News & Updates

factor measurements, and application-driven design.

A

Upload Data
Core Loss Q-Factor Permeability Ferrites Powdered Cores Amorphous-ManaCrystaliine Laminations

View Data

Working Groups Latest News & Updates

Technical Resources
Call for data: Temperature-dependent loss sweeps

Events & Webinars

Get Involved We're compiling open datasets of core loss vs. frequency, flux density, and temperature across common
core materials. Contribute your anonymized curves and fixtures.
About

Read more Contribute data

L
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[ ) coredatax_page3 htmi ® =

(] samaHouse [ watertown [ Armstrang  [] Amazen [ Dotster [JRecExpert [ GitHub [JEmPian  [Jugitys [Jsmou [ Thevenictricaidu [ Treio ] Encyclo_agnetica [ Midco webmail ) WE Space »

Signin

cox CoreDataX

PSMA sponsored cross-disciplinary technical forum focused on magnetic core charactization,
core losses, magnetic materials, modeling, and real-world design applications.

Upload Data
I ‘We're compiling open datasets of core loss vs. frequency, flux density, and temperature across common
View Data core materials. Contribute your anonymized curves and fixtures.
Working Groups Read more Contribute data ’

Technical Resources

Events & Webinars ‘Workshop recap: Practical Q-factor pitfalls

Get Involved
4 K G Slides and notes covermﬁ fixtures, parasitics, calibration, and translating Q at one frequency to another test
7 P < EF m About condition.
R Crniltirs_pnged et ® = View siides Watch recarding

Members Area

[)sumstouss [)wotertown [J armstong () Amazon [ Dotsier [ Redexpen  [Jomvup  (Jemeian  [Jugityss [Jsmou  [] Theveni circaiaw [) Trelo  [] Encycto_agnetica [) Midco webmat [ we space
Access private notes

psMn Power Sources Manufacturers Association signin recordings, and drafts. ,
Working Groups

PSMA | Technical Forums | N

cox CoreDataX

A PSMA sponsored cross-disciplinary technical forum focused on magnetic core charactization,
core losses, magnetic materials, modeling, and real-world design applications

Current driven core loss measurement

Upload Data Working Groups

View Data 5
Current driven core loss measurement

Working Groups

Technical Resources Exploring methods to measure core loss using a current driven source.

Events & Webinars

Joiny Notes [N
Get Involved
About Core loss 1 MHz to 100 MHz
Meets monthly - Open to contributors
Members Area Exploring methods to measure core loss above 1 MHz using resonant methods.
s private n
Join Notes

rdings, and drafts

Triple Pulse Testing method
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& DuckDuckGe 1 fist { View Options ~
] P x|+ o
[ ) coredatax_page3 himi ® =
[]) stamatouse () watertewn [ Armstrang  [] Amazen [] Dotster [ RedExpert [ GitHus [JEmPian  [Jugiityss [Jsmou [ Theveni_ctresidu [ Trele  [] Encyclo_agnetica [ Mideo webmail [ WE Space »

psnn Power Sources Manufacturers Association sign In Join

PSMA | Technical Forums | Magnetics

cox CoreDataX

A PSMA sponsored cross-disciplinary technical forum focused on magnetic core charactization,
core losses, magnetic materials, modeling, and real-world design applications.

Upload Data .
Technical Resources

View Data

Starter kit: fixtures & scripts
Working Groups : |

Docs - Code - CCBY 4,

Technical Resources : 3 5 ; i
Reference fixture drawings, calibration walkthroughs, and Python notebooks to get reproducible results

Events & Webinars fast. *

Get Involved Open docs Download zip

About
Reading list: Core loss & scaling

Members Area

Access private notes Key papers and notes on Steinmetz variants, frequency/flux scaling, and temperature dependence.
recordings, and drafts

Vhew Nst Suggest a paper

@AY P = pOEREN 200 O




PSMA Magnetics Committee Meeting Agenda — Special Projects — In Process

— Current driven core loss testing —
« Approved by PSMA BOD June 20, 2025

* Project can start upon receipt of 50% upfront gift payment
— PSMA to submit gift form
— Payment to University of Nebraska care of Jun Wang

« 50% final payment after approval of final report




PSMA Magnetics Committee Meeting Agenda — Special Projects — In Process

— Electrical parameters of magnetic materials — phase 2
 Final report available
* Approved payment with additional contingency expenses
* Need invoice from HSLU

 Place accepted report on special projects tab of Magnetics technical forum
— Add link to IEEE Xplore for associated APEC 2025 paper

¢ KPIS -y § \ilm‘; i 7
— Data 1 WS
— Methodology

Final report on website




PSMA Magnetics Committee Meeting Agenda — Special Projects Pending

— Pending
« Steinmetz like approximation
* Spice model
* Propagation in magnetic materials
Address after APEC 2026 planning meeting in October

Potential special project

European - Scholarship grant to 15 PhD connected with electronic components

* Magnetic materials More info may be available after October 22

* Modelling Students ready to start in January 2026
 Holistic design PSMA should make proposals by December 1
Hitachi 3 students For consideration during PSMA BOD December meeting

|dentify some preliminary ideas
Link students with specific magnetic committee members

PSMA
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« 2026 Workshop Planning
« 2026 Industry Session Planning
« Special Projects
— Core Loss Database
— Current Driven Core Loss
— Open Source BH Analyzer
— Core Loss for Frequency Range 1 MHz F 100 MHz
« Magnetics Forum on PSMA Website
* Open Magnetics
 Power Technology Roadmap
* Next Meeting




PSMA Magnetics Committee —Magnetics Committee Forum on PSMA Website

« Completed in 2024

— Section 1.3 Powdered metal
* Proposal by Lukas Mueller has been accepted
* Need to add to HF task force tab under magnetics Technical Forum on PSMA website

« Proposed additions/updates

— Section 1 Core Materials _ Address
« Sputtered (addition) sections 1, 4, 8 and 12
 Electroplated (addition) after 2026 WOFkShOp
» Section 1.4 Nanocrystalline and amorphous metals (populate) and ind ustry sessions
— Section 4 Inductors are finalized

« TLVR inductors (addition)
— Section 8 “Solid state” transformers (populate)

— Section 12 Fabrication Technology High frequency magnetics

« Section 12.3.2 Substrate embedded (populate) . N .
. Section 12.6 PSIP (populate) Add paragraph regarding definition of high

» Section 12.7 PwrSoc (populate) frequency dependent on applications

PSMA




PSMA Magnetics Committee —Magnetics Committee Forum on PSMA Website

https://psma.com/technical-forums/magnetics/hf-task-force

25 psma.com/technical-forums/magnetics/hf-task-force

PSMn News Publications Resources Conferences Technical Forums Membership About PSMA Contact Login Q

2% Magnetics Info & Resources

P~ for the Power Electronics Industry.

roduction [EEISEEN@ZIg M Magnetics Checklist | Resources | Presentations | Core Loss Studies | Meeting Minutes | Special Projects | Workshop

HF Task Force

PSMA Magnetics Committee High Frequency Task Force
January 11, 2015

At the PSMA Planning meeting in September 2013, the PSMA Magnetics Committee was strongly encouraged to do a workshop on high frequency magnetics.

Below is to the working document in which various topics of interest have been identified and grouped. This document will be
revised as new topics are suggested and input is received.

For the various topics, we solicit inputs from experts in the related field. White papers, application notes, slide presentation, audio
and video files all are welcome. As inputs are received, they will be summarized in the working document, and links will be added
to original files.

We have created a LinkedIn group, "PSMA Magnetics Committee High Frequency Task Force.
topics to provide a forum for questions and open discussion.

We will open threads on various

Celebrating 40 Years in Service

1988-2028
We encourage engineers to identify problems with magnetics that have hindered their high frequency designs. The more E - e
ower Irct
interesting problems may become discussion threads, locking for solutions. Manufacturers Assoclation

Steve Carlsen

Ed Herbert

Co-Chairmen

PSMA Magnetics Committee

High frequency magnetics

Revision: January 11, 2015
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. Near field noise performance

» 14. Software, design and simulation

» 15. Test equipment, quality assurance and production testing
» 16. Reliability
» Appendix
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2 Magnetics Info & Resources
7+ for the Power Electronics Industry.
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2025 Edition PSMA Power Technology Roadmap
Magnetics Section

« 2025 Topics (Submitted) « 2026/2027 Cycle Topics (Need to identify)

— Embedded Magnetics —
» Integrated Voltage Regulators (IVR) —
* Fully Integrated Voltage Regulators (FIVR) —
* Hybrid Integrated Voltage Regulators (HIVR) —
 Isolated Signal and Low Power Transformers —
 PwrSoC (Power Supply on Chip) —

Net Zero Bias TLVR

Solid State Transformers (SST)
Magnetic Materials

EV Charging

FIVR and/or HIVR

Wafer Level Magnetics

» Power Systems in Package (PSIP) — TBD
— Solid State Transformers (SST) — TBD
— Trans-Inductor Voltage Regulators (TLVR)
— Mother Board Voltage Regulators (MBVR)
+ Lateral Power Delivery (LPD) 2025 PSMA PTR Released June 2025

» Vertical Power Delivery (VPD)
* Dual Phase Power Block (DPPB)

Still in process of identifying chairs for the

e e e e
next cycle of the PSMA PTR?

s
— Core Loss Measurement Methods & Databases
— Magnetic Material Alternatives Opportunities and Limitations

PSMA




PSMA Magnetics Committee Meeting Agenda

 Introductions
« 2026 Workshop Planning
« 2026 Industry Session Planning
« Special Projects
— Core Loss Database
— Current Driven Core Loss
— Open Source BH Analyzer
— Core Loss for Frequency Range 1 MHz F 100 MHz
« Magnetics Forum on PSMA Website
* Open Magnetics
 Power Technology Roadmap
* Next Meeting




PSMA Magnetics Committee Meeting Agenda
— Next Meeting

 Wednesday December 3 10:00 AM CST — 11:00 AM CST Virtual




PSMA Magnetics Committee Meeting
Attendance (16)

John Horzepa

Kamyar Ahmadi

Mike Arasim

Andres Arias

Hasan Ahmadian Baghbaderani
Alan Cooper

Jim Cox

Doug Eaton

Frank Feng

Michael Freitag

Ed Herbert

Bryce Hesterman
Marcin Kacki
Mohammed Khodadadi
Alfonso Martinez
Jonas Multhahaler
Frank Oberlitner

Paul Ohodnicki

Lukas Mueller

Mike Ranjram
Rodney Rogers
Ranaijit Sai

George Slama

JC Sun

Tobias Trupp

Jun Wang — Bristol
Jun Wang - Nebraska
Ningning Wang
Matt Wilkowski

Fritz Wohlrath
Sebastian Bachman
Martin Kuo

Rickey Cheang
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Thank You
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